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Introduction

*What is EndNote?
*How EndNote works
*Compatibility and System Requirements

Download Endnote Software



What is EndNote?

Reference management software
® Developed by Clarivate Analytics

Personal Reference database
® Storing, managing, and searching for bibliographic references in your private

reference library

Bibliography and manuscript maker
® Formats citations in Microsoft Word with the Cite While You Write™ feature



How EndNote Works

MBS o>
Q

Books, Journals, Create bibliography Report, Manuscript,

Research Articles, Thesis, etc.

E-database, etc



Operating System Version Word processor software

Windows Windows 10  Microsoft Word [CWYW] :
Windows 11 2016
2019
2021
Office 365 (locally installed desktop version only)

Macintosh * mac0S10.14 Microsoft Word [CWYW] :
* mac0S10.15 2016

* macOS11 e 2019

* macOS 12 e 2021

* macOS13 » Office 365 (locally installed desktop version only)
* macOS 14

* macO0S 15

https://endnote.com/product-details/compatibility



https://endnote.com/product-details/compatibility

1. Go to https://softwaredownload.mahidol.ac.th/ (Access through MU-WiFi or VPN).

2. Login with the MU Internet account.

g% Mahidol University
. Mmr}mi-&wl

% Mahidol University 1

Software Download Sign In
Datruudomsis IT luumSnenasudaa :| A e ) ' with your Mahidol University Accounts.

UH3NENEBUR0a DAY ULVDUND:VIESUS:UUIUGTU IT ua: E
aussau:mo IT lRufus:sAusDLR0AlGIEUS:Tostae 0D = =5 Username

fiv ua:zivnasgunatisuiusvAnssuthuavlan lasldsa
L0S8UAUANSaHSU Software LNasTU IRUAAINSUDY
urBNendslaldou Password

-

Forgot password?



https://softwaredownload.mahidol.ac.th/

Download EndNote (2)

3. Select Application Menu

4. Download an installer compatible with your operating system and key license.

2 UHIDNUAUUHAA
Mahidol University
X G eelown it Leond

Mahidol University's Software License 9 EndNote

1 e
‘MATLAB .
EndNote 20

Microsoft Windows Microsoft Office Application

winssyuulfiidns windows dmsu uinsransiunls Microsoft Office dudu wdmsgaluiudng smsusiuau EndNote 21 for Windows & GET KEY LICENSE 2 DOWNLOAD
HIUIU LAZYUARTIAT UWTINENABLTIAR UL LAZUARIAS UWIINeNauuiina wAaAsLAZIAAAET NANNALUiaR

winrdansiuas ESET dwmiudiunu
uARINSUATINANEN W Inenauuiing




Get Started with EndNote

*EndNote Library Components
*Creating a New Library
Library Overview

e Journal Term Lists



EndNote Library Components

» EndNote libraries are made up of two parts:

| = | My Research Project - B X - EndNote Library file (*.enl)
File Home Share View 0
- Data folder (*.Data)
* U & Move to M Delete - Lﬁj‘ B EH select all
| | -2~ | |1} Select none These two parts must be kept together to work
Finto Quick Copy Paste _ Copy to Eename Mew Froperties _ )
access Iﬂ ) folder - DD Invert selection
Clipboard Organize Mew Open Select CorreCtly'
yN » My Research Project » v | 0 /2 Search My Research Project
~ Bl Testen » Keep EndNote libraries on your computer’s

# Quick access : Test.Datz EndMote Library

B Desktop ] _IF 4 bytes local hard drive. Storing and editing libraries on

¥ Downlosd ¢ a network drive can lead to corruption and
& Onelrive .

performance issues.

[ This PC

_J 3D Objects

B Desktop » EndNote libraries should never be stored in

Documents . .

4 Downloads cloud-syncing folders such as Google Drive,

d Music OneDrive, etc. Syncing folders corrupts

= Pirtures w7

== = EndNote libraries over time.

2 items




Creating a New Library

1. Go to File > New... or select Creating a New Library from the Setup Endnote Library box.
2. EndNote presents a dialog prompting you to enter a name for your new library.
3. Select the location where you will save the library.

4. Click Save, then the new Endnote library appears as an empty library.

- : EN Mew Reference Library 4
nces  Groups  Library  Tools
T @ » ThisPC » Documents 9 v | D £ Search Documents
r+0U Organize » Mew folder == = o
Open Shared Library... Ctrtl+Shift+0 & OneDrive A Name Date modified Type
3
Open Recent 1 e b Custom Office Templates 24/3/2563 9:43 File folder
— 15
- EndMote 26/4/2564 16:28 File folder
Close Ctrl+W 2D Objects o - _
= LDPlayer 2/4/2563 18:19 File folder
I Desktop 2 My Shapes 31/12/2561 12:29 File folder
Set up EndNote Library 5| Documents Zoom 22/3/2563 11:51 File folder
If you already have an EndMNote library, please locate it and we'll get it set up. ¥ Downloads
.. . J! Music
Open an existing library
| Pictures
m Videos
Alternatively, you can start from scratch with a new library. =5 05 e
= 05(C)
Create a new library e Rbe L v £ >
My EndMote Library.enl Q

File name:

Save as type: | EndMote Library (*.enl) ~

. Hide Folders e Cancel




Blank EndNote Library

File Edit References Groups Tags Library Tools Window Help

< Sync Configuration All References

B All References
A Recently Added
= Unfiled

= No reference selected

Advanced search

Trash

MY GROUPS

v My Groups

MY TAGS

FIND FULL TEXT
GROUPS SHARED B...
ONLINE SEARCH +
@ Library of Congress

® PubMed (NLM)

All References o
@

0 References

Author Year Title Journal Last Updated

@ Web of Science Co...

Search for group




Library Overview

Groups panel

shows you
both default
groups and
groups or
group sets you
create for your
research

projects.

remote database for new references to capture.

File Edit References Groups Tags Library Tools Window Help

ync Configuration
[ All References
2 Recently Added
B Unfiled
W Trash
v MY GROUPS

v Avian Intelligence

® Avian Cognition

=

@ Corvids
® Corvids & Parrots
& Parrots
Bats
) Chiroptera
! Echolocation
Echolocation OR Sonar
& Sonar
> My Groups
v MY TAGS
Bats
Corvids
B Parrots
v~ FIND FULL TEXT
~ GROUPS SHARED BY OTHERS

l laarch for aroun

All References

|Author v || Contains ~ ||
|And v || Year v ||C0ntains v || |
‘And v H Title v H Contains ~ H

Simple search  Search options ~

All References @ @

190 References

‘ Author Year ‘ Title Journal ‘ Last Updated ‘

2009 Leaf-nosed bat Encyclopzedia.. 21/08/2019
Aguilera-... 2020 Role of scaven...® Ecological l... 18/09/2020

Aizpurua,.. 2016  Fishing Techni... ® Plos One 18/09/2020
Allen, Glov... 2004 Bats: biology, b... = 21/08/2019
Arnett, E. B.. 2013 Evaluating the E.. ® PLoS One 18/09/2020

Avila-Flor.. 2004 Ecological, taxo.. ® Journal of Ma.. 17/09/2020
2008 21/08/2019
Binfield, Pe.. 2008 At PLoS ONE we..® PLoS: PublicL.. 21/08/2019

Bat Conser... Bat Conservation ...

Bird, C. D,;.. 2009 Insightful probl.. ® Proceedings.. 17/09/2020

Blanco, G... 2019 A shot in the ... ® Journal for... 18/09/2020

Brinklov, S... 2009 Intense echoloc... ® Journal of Exp... 17/09/2020

Reference List panel shows you the individual references

Search panel to find an item in your library or to query a

B,2009 #.. Summary Edit PDF [ &~ X

+ Attach file

Leaf-nosed bat
Encyclopaedia Britannica
Encyclopaedia Britannica Online 2009

http://www.britannica.com/EBchecked/topic/6933
86/leaf-nosed-bat

Vancouver e-pub ~ Insert Copy

1. Leaf-nosed bat. Encyclopaedia Britannica:
Encyclopaedia Britannica Online; 2009.

stored in your EndNote library, also known as library records.

Tab panel
The Summary

tab displays a
detailed
overview of a
selected
reference.
Quickly alter
reference
metadata from
the Edit tab.

Preview
panel shows

you how a
reference
would appear

formatted with

a specific

output style.




Journal Term Lists

Journal Term Lists are lists of journal names in full and abbreviated form.
® These lists are used for making correct journal names in reference format.

* Help EndNote work correctly to find out the duplicate references.

Recently Added

2 References

Author Year Title Journal . '
Li, Zhuo; Hirst, Jonathan D. 2020  Computed optical spectra of SARS-CoV-2 proteins Chemical Physics Letters €@ give full journal name
Li, Z.; Hirst, J. D. 2020 Computed optical spectra of SARS-CoV-2 proteins Chem Phys Lett PubMed*
give abbreviated journal name

“Retrieving references from various sources may give the journal names in a different form.




Before & After defining Journal Term Lists

Before After

piby
S
5l

ﬂ. ScienceDirect

"—::‘-l'

-|.-
'\.

Vancouver ¥ Insert Copy v Vancouver ¥~ Insert Copy A
1. Li Z, Hirst JD. Computed optical spectra o

1. Li Z, Hirst JD. Computed ontical spectra of
Give full journal name SARS-CoV-2 proteinsfiChemical Physics Letters SARS-CoV-2 proteinsfiChem Phys Lett.

2020;758:137935. 2020;758:137935.

Vancouver Style uses the abbreviated journal names



Define Journal Term Lists (1)

1. Go to Library > Define Term Lists...
2. In the Term Lists box, select tab Lists, then select Journals
3. Click on Import List...

Library HTools Window Help Term Lists x

Sync :
Advanced Search :

) My_Project_1.enl - Create List...
Sort Library...
. - Authors Rename List...
Find Duplicates Q Journals
Find Broken Attachment Links Keywords Delete List...
Open Term Lists »

o Define Term Lists... Ctrl+4
Link Term Lists... Ctrl+3 Delimiters Update List...
o =0
Find and Replace... Ctrl+R Custom Delimiter: Exoort List
Change/Move/Copy Fields Carriage return is always used asz a term delimiter, HPOTEEEE
Link Lists. ..

Recover Library...
Library Summary Close




Define Journal Term Lists (2)

4. Browse to G:\Program Files (x86)\EndNote 21\Terms Lists
5. Choose the appropriate term list files (e.g. BioScience.txt), then click Open to complete.

0. Select tab Terms to view the imported journal lists, then close.

Term Lists >
_C:\.Prngram Files (x286)\EndMote 20\ Terms Listsl l 4 2 Search Terms Lists
T — Lists
Organize + Mew folder - [ @

6231 Journals in the Journals List:

I Desktop 7 5 Anthropology.tet

Downloads Archaeology txt Full Journal Abbreviation 1
4 Downloads | Archaeclogy | Mew Term...
# OneDrive E A_gtmhom}' and Astrophysics.tit A Trends Guide Trends Guide
[ This PC g iI:SCI-enTem AADHM Journal AACHM 1., Edit Term...
z 15 emical bxt
— D OB 1 Economics.xt Journals Aarsberet, Mor. Fisk. Aarsberet, Mor,
Ct N
- e ) Humanities it Aarsberetning, MORCONS-RY Aarsberet, MOR! Delete Term
Deskt :
Djsw:ents [ Korean Medical Terms.ut o e e it e S Aarsberetning. Morsk Sjoefartsm... Aarsberet. Morsl Insert Term
2 Lawtxt Erms Inserted into the Journals term fst. Aarsberetning. Sildolje- og Sildem... Aarsberet, S5F
Medical.txt arsheretning. ns Kartwer arsheret,
¥ Downloads Aarsberetring. Statens Kartverk  Aarsberet. State
d Music | Philosophy.txt Aarsmelding. Eksportutvalget for... Aarsmelding Eks
| Pictures =] Physics.txt Aarsmelding. Fiskeriforskning Aarsmelding Fisk ¥
B videos D Religion.bt £ >
205 (C) D Zoological Records.tet
v Hint: Hold the Cirl key to select multiple terms
File name: |Ei|:uScier1ce.txt ~ || Text Fil gl (*.but)

Cancel

Close




Entering Reference Data

*Direct Export
*Import PDF

*Manual Typing



Entering Reference Data

Direct Export Import PDF Manual Typing

BT g e e :H E-Jt FHrHan-H '-EII'E-]LJ:JS Library Tools Window Help
FER T i
E}_'lﬁﬁf‘ . ' B/ UXX Q Save
ii ScienceDirect L A
T i . .
_.i'-_-i_,_. Reference Type |Journal Article |
A
'\ Year
LY
itl
PubX
® T ssue
C 0 LI S ppppp
Start Page

EEEEEEEE

ppppppppppppp

Google Scholar




Mahidol eJournal Access (EZproxy)

-
e b

Mahidol niversity

Library and Knowledge Center

Mahidol eJournal Access

™

I'm not a robot . o

reCAPTCHA
Privacy - Terma

firstname.sur (for staff) or u61xxx or g61xxx

type your password

> URL: https://ejournal.mahidol.ac.th

> Login with MU Internet account to access subscribed

e-resources

> Support all devices with all operating systems
(Windows, Macintosh, and Linux), smartphones and
tablets with iOS (iPhone / iPad) and Android

*** Limitation ***

Must follow the links given on the library’s website


https://ejournal.mahidol.ac.th/

Mahidol eJournal Access (EZproxy)

https://stang.sc.mahidol.ac.th GS >t . You can access it by:

Stang Mongkolsuk Library and Information Division (A) SeleCting the E'Resources

GContact us

es requires login with MU account viz: https://ejournal.mahidol.ac.th (B) Clicking the URL at the top of
‘ the webpage
\.

= (C) Clicking the eJournal Access
' I a button

(D) Selecting the desired
E-databases from the bottom

0 of the webpage

menu to find E-Databases,

E-Journals, or E-Books

Library Resources ™ Library Services ¥ Research Help Desk ¥ IT Help Desk ¥ Muse

Remaote access [off-campus]
E-DATABASES
E-JOURMALS
E-BOOKS
Search Guides/ Online Tuterials
Free Trial Databases

Thai Databaszes

THAI e-journals

>

- " duiPad WomisANW

E-DICTIONARY

— e b A -
FamaR Janaiaxmand oA~ Tar Ananmiemnin

List of Libraries in Thailand

Co-learning Stang
Space Training

Scopus  scencedirect  SciVal SIS R EBSCO  SCIFINDER g Acspubicatons
nature WakEY., Qs [l B TENE 2o Ovid'
[ 0[0) W] CGoogleScholar ~ 7Jturnitink EndNote™

eJournal

Access



https://stang.sc.mahidol.ac.th/

Direct export: ScienceDirect

Journals & Books ® Help 2 Myaccount  fi@ Mahidol University

<41 ScienceDirect

Search for peer-reviewed journal articles and book chapters (including open access content)

Find articles with these terms In this journal or book title Author(s)

Advanced search

Instantly surface, cite, compare and

E“ REKA ‘ explore trusted evidence from deep
’ ' within peer-reviewed literature with

EVERY D AY ScienceDirect Al.
! Explore ScienceDirect Al 71

® O O
ScienceDirect Al Confidence in research Climate change




Direct export:
gﬁ ScienceDirect SCienceDirect

Find articles with these terms

1. Select the records you coronavirus

XZ2_Advanced search
6 Export

] Download 25 articles
]
1

need.

. Click Export at the top

of the search results.

25 citations selected

. Click Export citation to

RIS to download data to Structure, Available online 29 April 2025
Chenghai Wang, Xiaoyan Nan, ... Jun Lan > Export citation to text
View PDF  Abstract v Graphical Abstract v

your device.

. Double-click on the Research article ® Open access

Anti-SARS-CoV-2 prodrug ATV006 has broad-spectriaa ScienceDirect_citations_T & a1 q animal

~ (]

downloaded file to
r 2 746155005304 ris

automatically open it in coronaviruses RIS Formatted File

. Acta Pharmaceutica Sinica B, Available online 10 March 2025
your library.
Tiefeng Xu, Kun Li, ... Deyin Guo

View PDF  Abstract ~  Graphical Abstract ~  Extracts ~  Figures v~ Export  [JRSSEES=07X@




Direct export: PubMed

National Library of Medicine P
National Center for Biotechnology Information ‘, J ,

PubfQed®

Advanced

PubMed® comprises more than 38 million citations for biomedical literature from MEDLINE, life science journals, and online books.
Citations may include links to full text content from PubMed Central and publisher web sites.



. Select the records you need.

. Click Send to at the top of
search results, then select

Citation manager.

. Setup the Selection to choose

number of the results.

. Click the Create file to

download data to your device.

. Double-click on the

downloaded file to

automatically open it in your

library.

National Library of Medicine

National Center for Biotechnology Information

Direct export:

PubMed

< I

User Guide

coronavirus

Advanced Create alert CaRSS

Clipboard

Save Email

Create a file for external citation management software

Clear selq

Selection (2)

L1

Selection:

My Bibliography

Collections

Citation manager

2003, there were only 10 coronaviruses with complete genomes available.

=ted interest in research on coronavirus iodiversity and genomics. Be

to December 2008, there was an addition of 16 coronaviruses ... Selection (2)

All results on this page
All results
Selection (2)

Broad-spectrum
Totura AL Bavari 5.

Expert Opin Drug Dis
&.

r pubmed-coronaviru. nbib
Jg NBIB Formatted File (

591 KB 0/17460441.2019.1581171. Epub 2019 Mar



Direct export: SCOPUS

Scopus

Start exploring

Q Search Lists  Sources  Scival=

Documents  Authors  Researcher Discovery  Organizations

©)

fim

Create account

Search tips @

Search within

Article title, Abstract, Keywords

Search documents *

+ Add search field [¥] Add date range Advanced document search >

Search History Saved Searches

Q

Start searching and your history will appear here. If you

need help to start searching, see our search tips.




Direct export:
Search within Search documents * scop us

Article title, Abstract, Keywords coronavirus
[] Save search |

g Set search alert <+ Add search field Reset

1. Select the records Documents  Preprints  Patents S

782 dOteents found
IE‘ Author(s) I:‘ Affiliations I:‘ Abstract I:‘ Number I:‘ Tradenames & manufacturers

Export wv
Ii‘ Document title D Serial identifiers (e.g. ISSN) I:‘ Author keywords D Acronym D Accession numbers & chemicals

Flle types E Year D PubMed ID D Indexed keywords D Sponsor D Conference information
Iil EID I:l Publisher I:l Funding text I:l Include references

Csv E Source title D Editor(s)
E Volume, issues, pages D Language of original document

RIS IE‘ Citation count I:‘ Correspondence address

. IE‘ Source & document type D Abbreviated source title
BibTeX ] publicati
ublication stage

Plain text (8] oor

Ii‘ Open access

Export 10 documents to EndNote as a RIS file ®

The RIS format is used for exporting references from Scopus to a reference management tool (e.g., Zotero, EndNote, RefWorks).
To import references to EndNote, open the .ris file with EndNote and follow the prompts. Make sure that .ris files are associated with EndNote on your system.

you need.

What information do you want to export?

E Citation information D Bibliographical information D Abstract & keywords D Funding details D Other information

Download

Click Export and

choose Reference

managers as
EndNote (RIS),

then it will present

Reference managers

MendEIey . Select all information [] save as preference
Refworks (RIS)

an Export

document setting

Box EndNote (RIS

Zhao, F,, Luo, Y., Li, B., Pulmonology, 31(1), 2025 0
different blood ... Zhong, N., Chen, R. pp. 2424642

Platforms

scival Feedbac

k




Direct export:
Export 10 documents to EndNote as a RIS file ©) scopus

The RIS format is used for exporting references from Scopus to a reference management tool (e.g., Zotero, EndNo

To import references to EndNote, open the .ris file with EndNote and follow the prompts. Make sure that .ris files 3. Select the record’s

information. (at least the

What infetion do you want to export? - . . .
Citation information is

Iil Citation information I:l Bibliographical information I:l Abstract & keywords I:l Funding details
recommended)

Iil Author(s) I:l Affiliations I:l Abstract I:l Number

Iil Document title I:l Serial identifiers (e.g. ISSN) I:l Author keywords I:l Acronym
Iil Year |:| PubMed ID I:l Indexed keywords I:l Sponsor data to your device.

@ EID D Publisher D Funding text
Iil Source title I:l Editor(s) . Doub|e_C|ick on the

Iil Volume, issues, pages I:l Language of original document

. Click the Export to download

Iil Citation count I:l Correspondence address downloaded file to

@ Source & document type D Abbreviated source title aUtOmatica”y open itin your
Iil Publication stage

[®] por

@ Open access

library.

SCOPUS.IIS
RIS Formatted File
Select all information 1.33 MB




Direct export: Google Scholar

— @ Myprofile Y& My library SIGN IN

Google Scholar

Stand on the shoulders of giants

@ EN Privacy Terms Help



= Google Scholar Direct export:

coronavirus

Articles About 2,390,000 results (0.06 sec)

. : . 1. Click the Cite icon
Any time A review of coronavirus disease-2019 (COVID-19)
Since 2025 T Singhal - The indian journal of pediatrics, 2020 - Springer for the record you
Since 2024 On 7th J 1 the virus was identified as a coronavirus that had >95% homology with the need
Since 2021 bat corongigiiimagd >

Custom range...

Sort by relevance
Sort by date

Any type

Review articles

include patents

v include citations

Create alert

¢ Save Cite
Coronavirus disec
K Dhama, S Khan, R Ti
... Coronaviruses can c
coronavirus 2 (SARS-C
¢ Save Y9 Cite Cite

Coronavirus pathc
SR Weiss, JL Leibowitz
... of murine coronaviru

(... We also review the f
Y% Save YU Cite Cite

Vancouver

Cite

Singhal, Tanu. "A review of coronavirus disease-2019 (COVID-
19)." The indian journal of pediatrics 87.4 (2020): 281-286.

Singhal, T. (2020). A review of coronavirus disease-2019
(COVID-19). The indian journal of pediatrics, 87(4), 281-286.

Singhal, Tanu. "A review of coronavirus disease-2019 (COVID-
19)." The indian journal of pediatrics 87, no. 4 (2020): 281-
286.

Singhal, T., 2020. A review of coronavirus disease-2019
(COVID-19). The indian journal of pediatrics, 87(4), pp.281-
286.

Singhal T. A review of coronavirus disease-2019 (COVID-19).
The indian jouré pediatrics. 2020 Apr;87(4):281-6.

BibTeX B EndNote} RefMan RefWorks

. Click the EndNote

to download data to

your device.

. Double-click on the

downloaded file to

automatically open

it in your library.

©

scholar.enw
EN EndNote Import File

188 bytes




Import PDF: File (1)

1. Go to File > Import > File... to open the Import File dialog.

T » ThisPC » Desktop » 2020 w (o] 2 Search 2020
2. Click Choose to select a PDF file from your hard drive. e e et
3- SeleCt Import Option aS PDF o Quick access "L Al-Eitan-2020-Bat-Borne Coronaviru,pdf 26-Mar-21 10:57 A...  Adobe Acrobat D.

@ OneDrive b Dimonaco-2020-Computational Analys.p...  26-Mar-21 11:00 A, Adobe Acrobat D,

™ Hasoksuz-2020-Coronaviruses and SA.pdf  26-Mar-2111:01 A.. Adobe Acrobat D.

4- CliCk Import to import a PDF file into your Iibrary- o This PC " Keeling-2020-Efficacy of contact.pdf 26-Mar-21 11:02 A...  Adobe Acrobat D.

;. 3D Objects b Khan-2020-Emergence of a Movel pdf 26-Mar-21 11:02 A...  Adobe Acrobat D.
[ Desktop
dit References Groups Library Tools 2020 -
File name: ~| | Files )
Open Library... Ctrl+0 | Open | |
Open Shared Library... Ctrtl+Shift+0O
Open Recent »
Close Library Ctrl+W _
Import File
Save Ctrl+5
Save As... T
’ -Fitan-2020-8Bat-Borne Coronaviru,
Save a CDpy IITll:Iﬂrt F|IE: I P

Import Option: 9 PDF -

: : Import Al e
o Import 3 File... Duplicates: po

Print... Ctrl+P olger.. Text Translation: Mo Translation i

Print Preview
Print Setup... G Cancel




Import PDF: File (2)

1111111.enl

Groups Library Tools Window Help

Imported References

ync Configuration

Nadeeshani, 2022 #67 Summary Edit

All References 11

aB ~[1]/12v —[ex]+ 2¢

Advanced search

% Imported Referen... 1
Recently Added 1
Unfiled 11

Imported References

1 Reference

1-s2.0-52090123221001491-main.pdf

AQ@

Trash

MY GROUPS
v My Groups 1arshani Nadeeshani; Jinyao Li; T...
FIND FULL TEXT

GROUPS SHARE...

ONLINE SEARCH +

@ Jisc Library Hub ...

@ Library of Congr...

@® PubMed (NLM)

® Web of Science ...

Search for group

5y Contants lists swailable a1 ScienceDimct
ﬁ Journal of Advanced Research

www.alsaviar

2022

jeurnal

Nicotinamide mononucleotide (NMN)...

Nicotinamide mononucleotide (NMN) as an anti-aging health product -
Promises and safety concerns

Harshani Madeeshani®, Jinyao Li", Tianlei Ying ‘. Bashong Zhang ', Jun Lu”

sepplementation.

ARTICLE

iaremencal Sciences, Auckland Usiversity of Technokigy, Auckland 0627, Mew Zealand.




Manual Typing (1)

Go to References > New Reference.

A blank reference window appears.

B 7 U X X

File Edit References

Q

Groups

Library

Tools

Window

— |

Help

Select a Reference Type from the drop-down

menu. (the default type is Journal Article)
Enter bibliographic data into the fields.

Saving reference by clicking the Save.

Groups Library Tools Windov

MNew Reference Ctrl+MN

dit Refterence

Copy References To r
Copy Formatted Reference Ctrl+K
E-mail Reference

Move References to Trash Ctrl+D

Reference Type |Journal Article At

Author
Year

Title
Journal
Volume
Part/Supplement
Issue
Pages
Start Page
Errata
Epub Date
Date

Type of Article

v

Conference Paper
Conference Proceedings
Dataset

Dictionary

Discussion Forum
Edited Book

Electronic Article
Electronic Book
Electronic Book Section
Encyclopedia

Equation

Figure

Film or Broadcast
Generic

Government Document
Grant

Hearing

Interview

Journal Article

Legal Rule or Regulation

Magazine Article
Manuscript

Map




Manual Typing (2)

How to enter the author's name
® Enter one name per line.

®* New Terms appear in red text.

Author names formats Institute/Corporate name formats

® First_name Middle_name Last_name * add a comma after the name.
Albert Einstein World Health Organization,

Albert Lester Lehninger Mahidol University,

ANUZDNENATNERNS UKIDNENauUrna,

® Last name, First._ name Middle_name

Einstein, Albert Thai author name formats

® add acomma after the name.

Lehninger, Albert Lester AUNWS J1uag0SaTsaU




Working with MS Word

*Inserting Citations
*Edit & Manage Citations
*Configure Bibliography

*Convert Citations and Bibliography



1. Place the cursor on the position where you would insert

the citation in Word document.

2. Goto the EndNote 21 menu, and select Go to EndNote |-

Inserting Citations (1)

AutoSave (@ Off) K) ~ 9/ ~ v

File

Citation ¥

1

Page 10f 1

55l o

My Manuscript.doot = ye; Kanokporn Ngamsawangrungrot KN

Home Insert  Desi ayout References Mailings Review View Zoterc Help {f EndNote 21 ) Acrobat
|,,| EN Go to EndNote le:  Vancouver v &Categorize References ¥ Exportto ndhNote ¥ OHeIp
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The study explored four popular Massive Open Online Course (MOOC) platforms -

, Udacity, and FutureLearn - to find courses suitable for librarian professional

development | JA content analysis approach was used to analyze course descriptions and syllabi.

e Tindings revealed that there were a total of 861 courses on Coursera, 336 on EdX, 48
on Udacity, and 98 on FutureLearn. Only three courses were directly related to the role of
librarians, offered by Coursera and EdX. These courses covered topics like copyright, metadata
organization, and library advocacy. Additionally, there were 14 courses relevant to information
technology and educational technology skills, and 28 courses suitable for improving generic

skills applicable to librarians.
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